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Licence for Use 
The software is protected by both United States copyright law and 
international copyright treaty provisions.  You may copy it onto a 
computer to be used and you may make archival copies of the software for 
the sole purpose of backing up Campbell Scientific Ltd. software and 
protecting your investment from loss.  All copyright notices and labelling 
must be left intact. 

The software may be used by any number of people, and may be freely 
moved from one computer location to another so long as there is no 
possibility of it being used at one location while it's being used at another.  
Under the terms of this licence, the software cannot be used by two 
different people in two different places at the same time. 

 

 

 

 

 

 

 

 
 

Campbell Scientific Ltd, 
Campbell Park, 80 Hathern Road, 

Shepshed, Loughborough, LE12 9GX, UK 
Tel: +44 (0) 1509 601141 
Fax: +44 (0) 1509 601091 

Email: support@campbellsci.co.uk 
http://www.campbellsci.co.uk 

 

 





Limited Guarantee 
The following warranties are in effect for ninety (90) days from the 
date of shipment of the original purchase. These warranties are not 
extended by the installation of upgrades or patches offered free of 
charge. 

Campbell Scientific warrants that the installation media on which the 
software is recorded and the documentation provided with it are free 
from physical defects in materials and workmanship under normal 
use. The warranty does not cover any installation media that has been 
damaged, lost, or abused. You are urged to make a backup copy (as 
set forth above) to protect your investment. Damaged or lost media is 
the sole responsibility of the licensee and will not be replaced by 
Campbell Scientific.   

Campbell Scientific warrants that the software itself will perform 
substantially in accordance with the specifications set forth in the 
instruction manual when properly installed and used in a manner 
consistent with the published recommendations, including 
recommended system requirements. Campbell Scientific does not 
warrant that the software will meet licensee’s requirements for use, or 
that the software or documentation are error free, or that the operation 
of the software will be uninterrupted.  

Campbell Scientific will either replace or correct any software that 
does not perform substantially according to the specifications set forth 
in the instruction manual with a corrected copy of the software or 
corrective code.  In the case of significant error in the installation 
media or documentation, Campbell Scientific will correct errors 
without charge by providing new media, addenda, or substitute pages. 
If Campbell Scientific is unable to replace defective media or 
documentation, or if it is unable to provide corrected software or 
corrected documentation within a reasonable time, it will either 
replace the software with a functionally similar program or refund the 
purchase price paid for the software.  

All warranties of merchantability and fitness for a particular purpose 
are disclaimed and excluded. Campbell Scientific shall not in any case 
be liable for special, incidental, consequential, indirect, or other 
similar damages even if Campbell Scientific has been advised of the 
possibility of such damages. Campbell Scientific is not responsible for 
any costs incurred as a result of lost profits or revenue, loss of use of 
the software, loss of data, cost of re-creating lost data, the cost of any 
substitute program, telecommunication access costs, claims by any 
party other than licensee, or for other similar costs. 

This warranty does not cover any software that has been altered or 
changed in any way by anyone other than Campbell Scientific. 
Campbell Scientific is not responsible for problems caused by 
computer hardware, computer operating systems, or the use of 
Campbell Scientific’s software with non-Campbell Scientific 
software. 

Licensee’s sole and exclusive remedy is set forth in this limited 
warranty. Campbell Scientific’s aggregate liability arising from or 
relating to this agreement or the software or documentation 
(regardless of the form of action; e.g., contract, tort, computer 
malpractice, fraud and/or otherwise) is limited to the purchase price 
paid by the licensee.  

 





PLEASE READ FIRST 
About this manual 

Please note that this manual was originally produced by Campbell Scientific Inc. primarily for the 
North American  market. Some spellings, weights and measures may reflect this origin. 

Some useful conversion factors: 

Area:   1 in2 (square inch) = 645 mm2 
 
Length:    1 in. (inch) = 25.4 mm 
                  1 ft (foot) = 304.8 mm 
                  1 yard = 0.914 m 
                  1 mile = 1.609 km 
 
 

Mass:    1 oz. (ounce) = 28.35 g 
 1 lb (pound weight) = 0.454 kg 
 
Pressure: 1 psi (lb/in2) = 68.95 mb 
 
Volume: 1 UK pint = 568.3 ml 
 1 UK gallon = 4.546 litres 
 1 US gallon = 3.785 litres 

 
In addition, while most of the information in the manual is correct for all countries, certain information 
is specific to the North American market and so may not be applicable to European users.  

Differences include the U.S standard external power supply details where some information (for 
example the AC transformer input voltage) will not be applicable for British/European use. Please 
note, however, that when a power supply adapter is ordered it will be suitable for use in your country. 

Reference to some radio transmitters, digital cell phones and aerials may also not be applicable 
according to your locality. 

Some brackets, shields and enclosure options, including wiring, are not sold as standard items in the 
European market; in some cases alternatives are offered. Details of the alternatives will be covered in 
separate manuals. 

Part numbers prefixed with a “#” symbol are special order parts for use with non-EU variants or for 
special installations. Please quote the full part number with the # when ordering. 

Recycling information 
At the end of this product’s life it should not be put in commercial or domestic refuse 
but sent for recycling.  Any batteries contained within the product or used during the 
products life should be removed from the product and also be sent to an appropriate 
recycling facility. 

 
Campbell Scientific Ltd can advise on the recycling of the equipment and in some cases 
arrange collection and the correct disposal of it, although charges may apply for some 
items or territories.  

  
 For further advice or support, please contact Campbell Scientific Ltd, or your local agent. 

 
 
 

Campbell Scientific Ltd, Campbell Park, 80 Hathern Road, Shepshed, Loughborough, LE12 9GX, UK 
Tel: +44 (0) 1509 601141    Fax: +44 (0) 1509 601091  

Email: support@campbellsci.co.uk 
www.campbellsci.co.uk 
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Section 1. Installation 
1.1 System Requirements 

HydroSense II Support Software is built on the .NET Framework 3.5, which has 
the minimum system requirements listed in Table 1-1. NET Framework 3.5 
Minimum Requirements (p. 1-1). 

Table 1-1. NET Framework 3.5 Minimum Requirements 

Operating 
System 

Windows XP SP2, Windows Vista, Windows 7, Windows 
Server 2003 
Windows Server 2008 

Processor 400 MHz Pentium processor or equivalent 

RAM 96 MB 

Hard Disk Up to 500 MB of available space may be required 

Display 800 x 600, 256 colours 
 

The software also makes use of resource intensive drawing libraries to display 
charts and 2D plots.  The recommended requirements to use these features are 
listed in Table 1-2. HydroSense II Software Recommended Requirements  
(p. 1-1). 

Table 1-2. HydroSense II Software Recommended Requirements 

Operating 
System 

Windows XP SP3, Windows Vista SP2, Windows 7 SP1 
Windows Server 2003 SP2, Windows Server 2008 SP2 

Processor 1.6 GHz Pentium 4 processor or equivalent 

RAM 512 MB 

Hard Disk 500 MB for the .NET framework 
an additional 10 MB for the HydroSense II software 

Display 800 x 600, 32 bit colour 
 

HydroSense II Support Software uses Bluetooth to communicate with the 
HydroSense II display.  A Bluetooth stack is required on the local PC to handle 
traffic between software and Bluetooth hardware.  Bluetooth hardware will be 
either a USB dongle or a built-in chip. 
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Supported Bluetooth Stacks 

Microsoft (included with Windows XP SP2, Windows Vista, and Windows 7) 

BlueSoleil (bundled in the form of BlueSoleil software with Bluetooth USB 
dongles) 

Toshiba (used by third parties, such as Dell and Sony, in laptops and USB 
dongles) 

Broadcom / Widcomm (one of the older stacks, also licensed to third parties) 

1.2 Installation CD 
An installation CD is supplied with the HydroSense II unit.  The CD contains the 
HydroSense II Support Software and the .NET Framework 3.5 for systems that do 
not have this already installed. 

To install the software, insert the CD into the PC CD-ROM drive.  The setup 
wizard should start automatically.  If it does not, browse to the CD-ROM drive in 
Windows® Explorer® and run setup.exe. 

 

If the .NET Framework 3.5 SP1 is not already installed, the wizard will prompt to 
install it from the CD.  Click Accept to continue. 
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The installation of .NET Framework 3.5 will take a couple of minutes.  Once the 
installation is complete, the install wizard will continue (SECTION 1.4 Install 
Wizard (p. 1-3)). 

1.3 Web Setup File 
Alternatively, HydroSense II Support Software can be downloaded from the 
Downloads menu at www.campbellsci.com.  The download does not include the 
.NET Framework.  To start the installation of the HydroSense II Support 
Software, double-click on HydroSoft.exe. 

If the .NET Framework 3.5 is not installed, the wizard will prompt to download 
the framework from Microsoft’s website. 

 

Click Yes to open a browser to download and install the .NET Framework, then 
run HydroSoft.exe again. 

1.4 Install Wizard 
The installation wizard begins with a welcome page: 

 

Click Next to continue.  The next page shows the default installation directory for 
the software. 
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In most cases, the default directory should be used.   

This page also asks whether to install the software for the current user or for all 
users on this PC.  This decides whether the desktop shortcut and Start menu 
shortcut will be visible to just the current user or to all users.  Click Next to 
continue. 

Click Next on the next page to begin installing the software. 

 

When installation is complete, close the wizard: 
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A shortcut to the software is placed on the desktop and in the Start menu under 
Programs > Campbell Scientific > HydroSense II.  This Start menu group 
contains two shortcuts. 

HydroSense II Support Software 

This shortcut will run the support software used to download and display data 
from the HydroSense II.  See SECTION 2. Quickstart (p. 2-1) for more 
information. 

Operating System Updater 

This shortcut will run the HydroSense II firmware update facility.  This is used to 
send an updated operating system to the HydroSense II display unit.  An OS 
update is required only if a new operating system has been released to add features 
or fix existing issues.  See SECTION 8. Operating System Updater  
(p. 8-1) for more information. 
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Section 2. Quickstart 
2.1 The Main Window 

The main window has three areas. 

 

1. Toolbar — used to connect to devices and download data. 

2. Central area — contains the Data, Chart, and Map tabs.  These tabs will 
become visible when data are downloaded from the HydroSense II.  More 
information can be found in SECTION 4. Viewing Data (p. 4-1). 

3. Status bar — displays errors that may occur while connecting to a device.  On 
start up, the status bar in the lower portion of the window should not show 
any errors.  It should show the information icon, .  If the software does not 
detect any Bluetooth hardware on the local PC, an error will be shown.  See 
SECTION 7.5 (0x11) BTStackError (p. 7-3) for more information. 

 

2.2 Discover Devices 
Press the Discover button in the toolbar to start searching for devices.  Depending 
on your Bluetooth hardware, this search could take up to 30 seconds to complete 
and cannot be cancelled. 
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When discovery is complete, the first discovered device is displayed in the Device 
List to the right of the Discover button.  To view all discovered devices, press the 
down arrow to the right of the device name. 

 

2.3 Connect to a Device 
Select the device that corresponds to the HydroSense II.  Device name will be 
“HYDxxxxx”, where xxxxx is the serial number of the display.  This will enable 
the Connect button.  Press Connect to connect to the HydroSense II.  

The first time the software connects to a specific HydroSense II, the user is 
required to enter a pairing code for the device.  All HydroSense II displays have 
the pairing code 1234. 

When connection is successful, remote battery voltage and clock are displayed in 
the toolbar. 

 

If the HydroSense II display clock needs updating, either wait for the first GPS 
time sync or see SECTION 3.3 Setting Time (p. 3-5) for instructions.  The 
HydroSense II should have its battery replaced at 4.00 V; it will not power up 
when the battery voltage reaches 3.60 V. 

More information on connecting to a device and possible connection errors can be 
found in SECTION 3.2 Connecting to a Device (p. 3-2). 

2.4 Download Data  
If the HydroSense II has new measurement or zone data, notification will be 
posted in the status area to the right of the Synchronise button. 
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To download new data, press the Synchronise button. 

 

After the download is complete, the status area indicates that the measurements 
and zones are now synchronized. 

 

For more information on downloading data see SECTION 3.4 Synchronizing with 
a Device (p. 3-6). 

2.5 View Data 
Downloading data from the HydroSense II will enable three tabs in the main 
window that enable viewing HydroSense II data. 

2.5.1 Data Viewing Tab 
The Data tab displays a list of all measurements sorted by time of measurement.  
Each row represents a single measurement and lists 

• the zone a measurement is located within 

• latitude and longitude of the measurement 

• details of the parameters measured 
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The timeline in the lower portion of the tab is used to filter the data by 
measurement time.  The sliders on either side of the table are used to scroll 
through the measurements. 

For more information on how to use the data tab viewing options, see SECTION 
4.3 Data Tab (p. 4-4). 

2.5.2 Chart Viewing Tab 
The Chart tab plots measurements for a given zone (or group of zones) over time.  
As the pointer is moved over the chart, time and soil moisture at the pointer 
position are shown in the upper-right.  If the pointer is moved close to a 
measurement, an info tip will display the measurement details. 

 

By default, the chart displays all measurements.  To view a chart for a specific 
date range, clear the Select All Dates checkbox and use the timeline (timeline is 
below the chart) to highlight a range of dates to display. 

For more information on using the Chart tab and the timeline, see SECTION 4.4 
Chart Tab (p. 4-9). 

2.5.3 Map Viewing Tab 
The Map tab displays measurements and zones on a two-dimensional plot.  
Average moisture is calculated for each zone from the measurements within the 
zone; the zone is coloured accordingly.  Moving the pointer over any point or zone 
displays an info tip with more detailed information. 
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By default, all measured points are displayed in the map.  The timeline (timeline is 
below the map) is used to filter the displayed points by a given date range. 

The toolbox at the right of the window can be used to move and resize zones.  
Double-click on a zone to set the zone radius or change the zone name. 

For more information on using the Map tab, see SECTION 4.5 Map Tab (p. 4-11).  
For more information on moving and resizing zones, see SECTION 4.5.6.1 Zone 
Editing Tools (p. 4-19). 
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Section 3. Downloading Data 
3.1 Discovering a Device 

The main toolbar contains the Discover button and the list of known devices.  

 

Press the Discover button in the toolbar to start searching for devices.  The 
HydroSense II should be in range of the PC and turned on. 

Depending on the Bluetooth hardware, this search takes up to 20 seconds and 
cannot be cancelled.  During discovery, the status bar flashes a discovery symbol 
to indicate that discovery is in progress. 

 

When discovery is complete, the first discovered device is displayed in the device 
list to the right of the Discover button. 

3.1.1 The Device List  
The device list contains all devices discovered in the current and previous 
sessions. 

Each HydroSense II is listed with its device name (HYD followed by the serial 
number) in bold, and its Bluetooth address is printed in smaller font beneath.  
Devices discovered in the current session are shown with a Bluetooth icon, .  

 

The software saves a list of devices previously discovered.  They can be selected 
directly from the list without a discovery step.  These devices are shown next to a 
folder icon, .  

If data have been previously downloaded from a particular HydroSense II, 
selecting that device in the list will update the software data display area to show 
data for that unit.  The device list controls which device has its data displayed in 
the software. 



Section 3.  Downloading Data 

3-2 

3.2 Connecting to a Device 
3.2.1 Connecting 

The Connect button controls connection to HydroSense II probes.  If a device is 
selected in the device list, the Connect button will be enabled. 

 

Press the Connect button to connect to the device.  The connection process should 
take only a few seconds.  The status bar will flash a Connect icon to indicate that 
the connection is in progress. 

 

The first time the software connects to a particular HydroSense II, a pairing step is 
required.  The pairing code is 1234.  See SECTION 3.2.2 Pairing with a Device (p. 
3-2). 

If the connection succeeds, an area next to the Connect button expands to show 
HydroSense II clock and battery voltage. 

 

The clock icon may be pressed to set HydroSense II time.  This will open a new 
window.  For more information, see SECTION 3.3 Setting Time (p. 3-5). 

If battery voltage is below 4.0 V, the batteries need replacing.  The HydroSense II 
will turn off if voltage drops to 3.6 V. 

During the connection process, the software asks the HydroSense II if it has any 
new data or zones.  If the connection process is successful, this information is used 
to update the status area to the right of the Synchronise button. 

 

Synchronizing data with the device is discussed in SECTION 3.4 Synchronizing 
with a Device (p. 3-6). 

3.2.2 Pairing with a Device 
The first time the software connects to a specific HydroSense II, the user is 
required to enter a pairing code for the device.  For all HydroSense II displays, the 
pairing code is 1234. 
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After pressing the Connect button, the Bluetooth stack on the local PC will ask for 
the pairing code.  The method used to ask for this code varies between Bluetooth 
stacks.  This page shows the procedure for the Microsoft stack running on 
Windows 7. 

A notification will appear in the notification area of the Windows Desktop (lower-
right). 

 

Click the notification to open the "Add a device" window. 

 

Enter the pairing code 1234, and then press Next. 

Close the "Add a device" window by pressing the Close button.  Windows will 
install the necessary drivers to communicate with the HydroSense II; the progress 
will be shown above the Windows task bar. 
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Once the installation is complete, the HydroSense software will connect to the 
HydroSense II. 

3.2.3 Disconnecting 
The software does not need to be connected to a device to view downloaded data. 

The software does need to be connected to the HydroSense II display to perform 
the following. 

• Download new measurements 

• Download new zones 

• Upload new or modified zones 

• Change settings 

• Set the HydroSense II display clock 

Maintaining a Bluetooth connection consumes battery power.  Disconnect and 
power down the HydroSense II after a data download to conserve battery life.  All 
other software functions are available while disconnected. 

3.2.4 Connect Errors 
The following errors may occur when connecting to a device.  Detailed 
information on each error can be found in SECTION 7. Error Codes (p. 7-1). 

• BTUnkownError - an error has occurred during the connection and the local 
Bluetooth stack did not specify the reason. 

• BTSocketError - there was an error creating a Bluetooth connection to the 
device. 

• HydrocolNoResponse - a Bluetooth connection to the HydroSense II display 
was created, but the device is not responding to commands from the software. 
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3.3 Setting Time 
Manually adjusting time and date is not normally necessary.  GPS derived time 
will override time and date set with this menu.  The time setting facility is 
generally used to set the clock when GPS synchronization is disabled or GPS 
power is turned off. 

3.3.1 The Set Device Time Window  
When connected (SECTION 3.2.1 Connecting (p. 3-2)), HydroSense II time 
appears next to the Connect button in the main toolbar. 

 

Press the clock icon to open the Set Device Time window.  

3.3.1.1 Set to System Time 
By default, the window is configured to set the device time to the same time and 
time zone as the local PC (Set to System Time option is selected).  

 

With this option selected, the time and time zone edit boxes are disabled, but will 
update once per second to the current system time.  

Press the Set button to update the device with the current system time.  
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3.3.1.2 Set to Custom Time 
To set HydroSense II time to a custom time or time zone, select the Set To: option.  

 

This enables the time and time zone edit boxes.  Enter the custom date and time 
into the edit boxes.  To set the date using a calendar, press the drop down arrow on 
the date edit box.  

In the Item list, select the desired time zone.  

Press the Set button to update the device with the custom time or time zone.  

3.4 Synchronizing with a Device 
The Synchronise and Settings buttons of the main toolbar are disabled until a 
Bluetooth connection is made. 

 

After connection, synchronization status information is placed to the right of the 
Synchronise button.  Status information shows whether data or zones need to be 
downloaded from the HydroSense II, or if zones need to be uploaded. 
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The following table shows the possible states that may be shown in the status area, 
and the action each performs. 

Table 3-1. Status Area States 

State Action Performed 

 
The latest record stored on the 
device is newer than the latest 
record stored on the PC. 
The PC will download the new 
records from the device. 

 The latest record stored on the 
device is the same as the latest 
record stored on the PC.  
No action is needed. 

 
The zones stored on the device 
have changed since the last 
synchronization.  If the zones 
stored on the PC have also 
changed since the last 
synchronization, device zone 
changes take precedence and will 
overwrite the zones stored on the 
PC. 
The PC will overwrite its zones 
with those from the device. 

 
Since the last synchronization, the 
zones stored on the PC have 
changed, but the zones on the 
HydroSense II have not. 
The device will overwrite its zones 
with those from the PC. 

 
The zones on the device match 
those stored on the PC.  
No action is needed. 

 

3.4.1 Synchronizing 
Press the Synchronise button to perform the download and upload actions 
indicated in the status fields.  The status display will change to show the download 
and upload progress for each file on the device. 
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After synchronization is complete, the status display will show that data and zones 
are synchronized. 

 

The connection with the HydroSense II can be disconnected after synchronization.  
Newly downloaded data can be viewed without an active connection. 
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Section 4. Viewing Data 
4.1 Using the Timeline 

The timeline shows an overview of water content over time. 

The Data, Chart, and Map tabs use a common timeline to filter measurements 
based on the time they were taken.  The timeline is shown in the lower portion of 
each tab. 

By default, the timeline has the Select All Dates checkbox selected.  This means 
that all measurements will be displayed in the active tab. 

To start filtering measurements by timestamp, clear the Select All Dates 
checkbox.  This will enable timeline control. 

 

The following figure shows water content for the month before 4 July, 2011.  The 
length of time shown in the timeline is displayed in the upper-left (1 Month), and 
the ending date shown in the timeline is displayed in the upper-right (04 July, 
2011). 

 

Part of the timeline around 13 June 2011 is highlighted to indicate points currently 
shown in the main view.  This highlighted area can be moved to the left and right 
by clicking and dragging the scrollbar beneath the timeline. 

 

Dragging the scrollbar all the way to one edge of the timeline will scroll the 
timeline background to bring earlier (or later) points into view.  Notice that the 
timeline is adjusted such that data for only one month are shown. 

 

Dragging the scrollbar to the far left of the screen adjusts the timeline such that 
water content data for a month ending on 13 June are displayed. 

The length of the highlighted area are changed by clicking and dragging the 
sliders on either side of the selection. 
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Extending the highlighted area to cover more than 80% of the timeline will cause 
the timeline to zoom out and a longer date range of data to be displayed. 

 

Notice that the timeline now shows 3 months of data. 

 

Likewise, reducing the length of the highlighted area to cover less than 20% of the 
width of the timeline causes the timeline to zoom in and data from a smaller date 
range to be shown. 

 

 

Notice that the timeline is now showing 1 month of data.  To stop filtering by date 
and display all points, select the Select All Dates checkbox to disable timeline 
control. 
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When large numbers of measurements are updated, the process may take a few 
seconds.  A loading icon will be displayed while the view is refreshed. 

 
 

4.2 Showing / Hiding Zones 
Zones menus in the Data and Chart tabs facilitate showing or hiding 
measurements by zone. 

 

By default, all zones are shown and listed in alphabetical order; clear the Select 
All checkbox to enable individual zone checkboxes.  
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Clearing individual zone checkboxes will remove measurements from those zones.  
If the Select All checkbox is cleared and no individual zones are selected, no data 
are displayed. 

The [Unspecified Zone] is a special zone that contains all the points that are not 
located in any of the other zones. The [No GPS Lock] zone is a special zone that 
contains all the points that were collected without positional information. 

 

4.3 Data Tab 
4.3.1 Records Display 

The Data tab displays all records downloaded for the current device in detail. The 
tab has three sections. 

 

1. Menu Bar 

The menu bar has a Zones menu and an Export menu.  The Zones menu allows the 
user to display or hide measurements by zone.  See SECTION 4.2 Showing / 
Hiding Zones (p. 4-3) for more information. 

The Export menu allows the user to output a .csv file containing the measurements 
currently in view.  See SECTION 4.3.3 Export Menu (p. 4-8) for more 
information. 

2. Data List 

The data list contains measurements downloaded from the HydroSense II.  
Measurements shown in the list can be filtered using the Zones menu or the 
timeline. 

Row colour indicates a range of volumetric water contents.  Colours default to red 
for low soil water, yellow for midrange soil water, and green for high soil water.  
For information on customizing colours, see SECTION 5.3 Measurement  (p. 5-6). 
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The following columns are in the data list: 

Table 4-1.  Data List 

Element Description 

TimeStamp HydroSense time when the measurement was made 

Record 
Number 

Record numbers range from 1 to 65535 

Zone Zone where this measurement is located 

Latitude Latitude (°N of the equator) where this measurement was 
made 

Longitude Longitude (°E of the prime meridian) where this measurement 
was made 

Moisture ( % ) Volumetric water content (VWC) reported in percent (%). 
Only water content is plotted on the Chart tab.  Additional 
raw measurements with units are shown in the Data tab 

 

3. Timeline 

The timeline allows the user to filter the points in the data list based on when the 
measurements were taken.  By default, the Select All Dates checkbox is selected 
and all measurements are displayed.  For information using the timeline, see 
SECTION 4.1 Using the Timeline (p. 4-1). 

4.3.2 Point Options 
4.3.2.1 Find In Map View 

To locate a given point in the Map View, right click on the desired row (multiple 
rows can also be selected) in the Data View and choose Find In Map View. 
Alternatively, double clicking on the row will perform the same function. 
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The Map View will appear and the selected points will be highlighted with cross 
hairs for 3 seconds. 

 

The map will automatically pan to ensure all of the selected points are visible. 

4.3.2.2 Select All Rows 
All rows in the Data View can be selected by right clicking anywhere in the data 
list and choosing Select All. 

 

This will select all rows in the current view (it will not select rows which are 
currently hidden by the choice of visible zones or the date range). 
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4.3.2.3 Removing Records 
Unwanted measurements are removed by right-clicking on the measurement row 
and selecting the "Remove selected points" command. 

 

The software will prompt for confirmation of the removal.  Once a measurement is 
removed from the list, it cannot be recovered. 

Multiple measurements can be removed by holding the CTRL key and selecting 
the desired rows, and then right-clicking and choosing the “Remove selected 
points” command. 
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4.3.3 Export Menu 
The Export menu can be found at upper-left of the Data tab 

 

The menu contains a command to export the measurements listed in the Data tab 
to a .csv file.  A .csv file can be opened in Excel® or similar spreadsheet 
applications. 

First, select the appropriate range of dates from the timeline in the Data tab.  Click 
the “To CSV (Excel)” command from the Export menu.  A Save As dialog box 
will prompt where to save the .csv file.  Choose a location and press Save.  All 
columns shown in the Data tab will be exported to the .csv file. 
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4.4 Chart Tab 
4.4.1 Chart Tab Sections 

The Chart tab plots volumetric water content (VWC) from each measurement 
against time.  The tab has three sections.  

 

1. Menu Bar 

The menu bar has a Zones menu and an Export menu.  The Zones menu allows the 
user to display or hide measurements by zone.  See SECTION 4.2 Showing / 
Hiding Zones (p. 4-3) for more information. 

The Export menu allows the user to output a .csv file containing the measurements 
currently in view.  See SECTION 4.3.3 Export Menu (p. 4-8) for more 
information. 

2. Chart 

The chart plots volumetric water content as a function of time.  The plot can be 
scrolled using the timeline, and the measurements included in the plot can be 
filtered using the Zone menu.  The chart plots volumetric water content as a 
function of time.  The plot can be scrolled using the timeline, and the 
measurements included in the plot can be filtered using the Zone menu. 

Moving the pointer over the chart displays a vertical line that will follow the 
pointer to indicate the volumetric water content at the pointer position.  The text at 
the upper-right of the plot shows time of the point over which the pointer is 
currently paused, with the associated interpolated water content.  Interpolated 
water content is the water content expected given the measurements directly 
before and after the pointer position.  The text at upper-left of the plot shows the 
range of dates currently shown in the plot.  If the pointer moves close to a 
measurement, the pointer changes to dark blue and an info tip is displayed listing 
time the measurement was made, VWC in percent (%), and the zones to which the 
measurement belongs. 

The background of the chart is a gradient of colour defaults used in the 
HydroSense II software.  This is the colouring scheme used as the background for 
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rows in the Data tab and used to colour measurements and zones in the Map tab.  
To change these colours, see SECTION 5.3 Measurement  (p. 5-6). 

3. Timeline  

The timeline is used to scroll the chart as well as zoom in and zoom out.  For more 
information on how to use the timeline, see SECTION 4.1 Using the Timeline (p. 
4-1).  

4.4.2 Export Menu 
The Export menu can be found at the upper-left of the Chart tab. 

 

The Export menu facilitates exporting the current chart to a colour or black and 
white image file.  Clicking on either of the commands opens a Save As dialog box 
to choose the location to which to export the file.  The file can be saved as .png, 
.jpg, or .bmp.  Following are samples of the two image outputs. 

Sample Chart Export (Colour) 
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Sample Chart Export (Black and White) 

 
 

4.5 Map Tab 
4.5.1 Map View Sections 

The Map tab plots measurements and zones on a 2D map and colours them 
according to aggregate measurement values.  The Map tab does not provide the 
option to import a background image on which to plot, but it can export the 
current map view to Google Earth for viewing against satellite imagery.  The Map 
tab has three areas. 

 

1. Menu Bar 

The Zones menu lists all zones plotted in the main map and allows the user to 
zoom to a particular zone by double-clicking on its entry in the list.  See SECTION 
4.5.3 Zones List (4-14) for more information. 
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The Export menu allows the user to export the current view to either KML format 
to import into Google Earth, or GPX format, which supports many mapping 
applications.  See SECTION 4.5.4 Export Menu (p. 4-15) for more information. 

2. Map 

The date range of the points displayed is shown at the upper-left of the main map.  
This is the date range which has been chosen with the timeline. 

The size of the current viewing area, in metres, is displayed at the bottom left-
hand side of the map.  The size of the map can be changed by zooming in and out 
or by resizing the main window.  The area is expressed as width by height. 

A toolbar is located on the right of the map.  It contains tools to change zone sizes 
and positions. See SECTION 4.5.6.1 Zone Editing Tools (p. 4-19) for instructions 
on how to use this toolbar. 

A zoom slider is located on the left-hand side of the main map.  This can be used 
to change the current zoom level in increments by clicking the + and - buttons or 
continuously zooming in by using the slider. 

If Google Earth is installed on the local computer, clicking the button at the lower-
right of the map will show the contents of the view in Google Earth.  More 
information on this can be found in SECTION 4.5.5 Show in Google Earth (p. 4-
16). 

            

Zones 

Zones are shown to scale on the map.  The relative sizes of the zones match the 
diameters chosen on the HydroSense II.  Each zone is coloured according to the 
average VWC of all points contained in the zone.  Colours used to represent 
different levels of VWC can be changed as described in SECTION 5.3.4 Changing 
Measurement  (p. 5-8). 

Pausing the pointer over a zone will produce an info tip that lists the average 
VWC of this zone and the zone diameter and number of contained points.  The 
diameter of the zone is shown in brackets next to the zone name. 

Right-clicking on the zone shows the Zone Context menu, which has the 
following commands: 

• Edit — opens the Edit Zone window where the zone name and diameter can 
be changed.  For more information, see SECTION 4.5.6 Edit Zone Window (p. 
4-18). 
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• Zoom To — zoom in to the current map view to show only the selected zone. 

• Remove — removes the zone from the software and from the HydroSense II 
device on the next synchronization.  A dialog box will ask the user to confirm 
this action. 

          

Points 

Measurements are shown on the map as small cross marks.  These cross marks are 
not drawn to scale and do not change size during zooming.  Each cross is coloured 
according to the VWC for the measurement.  The colours used to represent 
different levels of VWC can be changed as described in SECTION 5.3.4 Changing 
Measurement  (p. 5-8). 

Pausing the pointer over a cross mark will produce an info tip listing the 
timestamp, VWC and zones containing the measurement. 

Right clicking on the zone shows the zone context menu, with the following 
options: 

• The Find in Data View menu option will display the Data View and select the 
appropriate row for this measurement.  This is the default action for a point 
and double clicking on the point will perform the same function. 

• The Create New Zone menu option will create a new zone centred on the 
selected point (see SECTION 4.5.2 Creating a New Zone (p. 4-13)). 

3. Timeline 

The timeline allows the user to filter the measurements shown in the map based on 
when measurements were taken.  By default, the Select All Dates checkbox is 
selected, and all measurements are displayed.  For more information on how to 
use the timeline, see SECTION 4.1 Using the Timeline (p. 4-1). 

4.5.2 Creating a New Zone 
New zones can be created from the Map View by right clicking on an empty area 
on the map or on an existing point, then choosing Create New Zone. 

 



Section 4.  Viewing Data 

4-14 

 

This will create a new zone centred on the cursor position or on the selected point. 

 

The name of the zone will be automatically generated and the radius will be set to 
a quarter of the Map View height (with a minimum of 3 metres).  Double click the 
new zone to change the name and size or use the Zone Editing Tools to resize or 
move the zone. 

The new zone will not yet exist on the HydroSense II hand held unit; it will be 
uploaded to the unit on the next Synchronization. 

 

4.5.3 Zones List 
The Zones list menu can be found at the upper-left of the Map tab. 
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This menu lists the zones stored on the HydroSense II with the number of points 
in each zone.  The zones will be listed in alphabetical order.  Double-click on a 
zone to zoom to that zone in the Map tab. 

 

Zone editing commands are available by right-clicking on the zone in the Map tab.  
See SECTION 4.5 Map Tab (p. 4-11) for more information.  

 

4.5.4 Export Menu 
The Export menu can be found at the upper-left of the Map tab. 

 

The menu facilitates exporting map data to one of two formats.  Clicking on either 
of the commands will open a Save As dialog box to choose the location of the 
exported file.  Only the points currently visible on the map will be exported.  To 
export all points, select the Select All Dates checkbox in the timeline. 
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KML 

KML is the Google Earth file format.  The .kml file contains both zone and 
measurement information.  Zones are displayed as coloured circles; measurements 
will be displayed as coloured drawing pins.  The colour of the circles and drawing 
pins will be the same as the colours shown in HydroSense II Support Software. 

GPX  

This is a standard GIS format used by many mapping packages.  Google Earth 
supports GPX files, but the GPX format does not allow for drawing shapes, so 
only measurement information is stored in the exported GPX file.  Each 
measurement is stored as a GPX waypoint with a timestamp.  The VWC 
measurement is stored in the waypoint description. 

 

4.5.5 Show in Google Earth 
The Show in Google Earth button is located at the lower-right of the Map tab.  
This button is visible but disabled if Google Earth is not installed. 

 

Clicking this button will open Google Earth and display the currently visible zones 
and measurements against Google Earth satellite imagery. 
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4.5.5.1 Zones 
Zones are displayed to scale as coloured circles.  Circle colour is determined by 
the average VWC of all points in a zone.  Click the zone to view an info tip with 
more information about the zone. 

 

4.5.5.2 Measurements 
Measurements are displayed as pin markers in Google Earth.  Each marker will be 
coloured according to the VWC measured at that point.  Click on one of the 
markers to view an info tip with more information about the measurement. 
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4.5.6 Edit Zone Window 

 

The Edit Zone window can be displayed by double-clicking a zone in the 
HydroSense Support Software map or right-clicking the zone and choosing the 
Edit command. 

Note that the Set button will be disabled until a zone setting has been changed. 
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The following zone settings can be changed and saved by pressing the Set button.  
The Set button will be disabled until a change is made to the zone settings.  Any 
changes made to zones on the local PC will be uploaded to the HydroSense II on 
the next synchronization. 

Name  

This field is used to name the zone in the software and on the HydroSense II 
handheld display.  The maximum length of the name is 15 characters. 

Radius  

This field specifies the radius of the zone in metres.  This field only accepts 
numeric characters (numbers and the period character “.”).  The minimum 
allowable zone radius is 3 m. 

Centre Latitude and Centre Longitude cannot be edited from the Edit Zone 
Settings window.  To change the location of a zone, use the Move Zone tool in the 
map as described in SECTION 4.5.6.1 Zone Editing Tools (p. 4-19). 

4.5.6.1 Zone Editing Tools 
The toolbar at upper-right of the map contains tools to control map position and 
edit zones. 

 

 

 



Section 4.  Viewing Data 

4-20 

1. Drag Mode  

By default, the hand icon is selected, so the map is in drag mode by default.  
Clicking and dragging anywhere on the map pans the view.  Moving the mouse 
wheel while pausing over the map zooms the view in and out. 

2. Move Mode  

Clicking the move tool puts the map in Move Mode.  Clicking and dragging on 
any zone makes the zone move with the pointer.  This tool is used to reposition 
zones on the map. 

 

While dragging, the position of the pointer on the map is displayed in the upper-
right of the map.  An info tip is displayed to show the number of contained points 
and average moisture for the current zone position. 

Right-clicking anywhere on the map, or selecting the hand tool from the toolbox, 
puts the map back into Drag Mode. 

3. Resize Mode  

Clicking the resize tool puts the map in Resize mode.  Clicking and dragging on 
any zone will increase or decrease its radius with the position of the pointer.  This 
tool can be used to resize zones on the map. 

 

While dragging, an info tip will show the current radius of the zone in metres with 
the number of contained zones and the average moisture at this zone size.  Right-
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clicking anywhere on the map or selecting the hand tool from the toolbox puts the 
map back into Drag Mode. 

4. Zoom-to-Extents  

Clicking the zoom-to-extents button will re-centre the view so that all points for 
the selected date range are visible. 
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Section 5. Settings and Configuration 
5.1 Bluetooth Settings 

The Bluetooth Adapters window can be accessed from the Options menu in the 
main window. 

 

The window shows a list of all available Bluetooth adapters on the local PC. 

 

The Bluetooth adapter currently being used by the HydroSense II software is 
shown in bold.  If there is more than one Bluetooth adapter on the local computer, 
the extra adapters are shown in normal font in the list. 

Each adapter is listed in the following format: 

Adapter Name (Adapter Bluetooth Address) | Bluetooth Stack Used 

To use a different adapter, select the adapter in the list and press the Activate 
button.  The new adapter is shown in bold.  This setting is saved to disk so that 
this adapter will be used the next time the software is run. 
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If the local PC does not have Bluetooth adapters connected, the following window 
will be displayed. 

 

See SECTION 7.5 (0x11) BTStackError (p. 7-3) for more information. 

5.2 Device Settings 
Settings for the HydroSense II can only be accessed when a Bluetooth connection 
has been established.  Click the Settings button in the main toolbar. 

 

The software will first download the settings from the device. 
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Then the Device Settings Window will be displayed. 

 

The device settings shown in the window will depend on the current version of the 
operating system.  The settings in the preceding figure are for the first released 
version of the HydroSense II display operating system.  
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Move the pointer over the labels at the left of the screen to see more information 
about each setting. 

 

Change settings using the list boxes and sliders.  The Apply button will be 
disabled until a setting is changed.  Press Apply to save the settings to the 
HydroSense II. 

After pressing Apply, the main window will show the settings file being uploaded 
to the HydroSense II. 

 

5.2.1 Saving Settings 
During a firmware upgrade, the device settings of the HydroSense II will be lost.  
The Device Settings window can be used to save the settings before the upgrade. 
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Open the Device Settings window, then click the Save button. 

 

Choose a location on the local PC to save the settings in an .xml file, then click 
Save. 

 

5.2.2 Loading Settings 
Open the Device Settings window, then click the Load button. 
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Browse to the location of the settings .xml file on the local computer and click 
Open. 

 

The window will be updated with the saved settings.  Press the Apply button to 
update the HydroSense II display with these settings. 

5.3 Measurement Colours 
HydroSense II Support Software provides three ways to visualize data: Data tab, 
Chart tab and Map tab.  In each tab, colours are used to represent the value of 
volumetric water content (VWC) from a measurement. 
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5.3.1 Data Tab  
The background of each data record is coloured based on the VWC measured at 
that point. 

 

5.3.2 Chart Tab 
The background of the chart is coloured with bands to show colours used for each 
level of VWC.  

 

5.3.3 Map Tab 
Zones in the map are coloured based on the average VWC of all the measurements 
located within that zone. 

Measurements are coloured based on the VWC measured at that point.  
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5.3.4 Changing Measurement Colours  
The default rules for deciding on the measurement colour are shown in Table 5-1. 
Default Measurement . 

Table 5-1. Default Measurement Colours

Moisture Range Colour 

0% < Moisture < 10% Red 

10% < Moisture < 20% Light Red 

20% < Moisture < 30% Orange 

30% < Moisture < 40% Light Green 

40% < Moisture < 50% Green 
 

These colour levels can be customized.  Click the Options menu in the main 
window, and choose Reading Colours. 

 

The window contains six edit boxes and five colour buttons. 
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Each colour button is positioned between two edit boxes.  The values in the edit 
boxes represent the upper and lower VWC limits for the reading colour shown on 
the colour button between them. 

In the default configuration, the colour RED is positioned between the values 0 
and 10.  This means that measurements between 0% and 10% VWC are assigned 
the colour RED. 

To change the levels at which colours begin and end, edit the values in the edit 
boxes.  The preview at the right of the window will update automatically.  The 
edit boxes will accept only numeric digits and will show a red outline when an 
invalid entry has been made. 

The 0% and 50% edit boxes are disabled; these represent the minimum and 
maximum output from the sensor and cannot be edited. 

To change the colours displayed, click the desired colour button to open a 
selection dialog box. 

 

Click one of the colours in the selection dialog box.  The dialog box will close, 
and the selected colour button will update its background to the selected colour.  

To close the dialog box without making a selection, click anywhere else in the 
Reading Colours window. 
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At the right of the Reading Colours window is a sample chart background.  

 

This sample background updates automatically when changes are made to the 
values and colours on the left.  It shows the background to be used for the Chart 
tab given the current selections. 

Press the Reset to Defaults button to revert the reading colours to the factory 
default selections (shown in the preceding figures).  

Press the Close button to save changes and return to the main window.  
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Section 6. Terms 
6.1 Bluetooth Adapter 

The Bluetooth adapter is a hardware device connected to the local PC that 
transmits and receives radio signals required for Bluetooth communications. 

On desktop computers, the adapter is usually a USB device that connects to a USB 
port on the computer.  If the HydroSense II Support Software is reporting a 
BTStackError, check that the USB device is firmly inserted into a USB port on the 
PC.  The Bluetooth stack on the computer should recognize that the device is 
attached. 

On laptop computers, the adapter is often built into the laptop hardware so that an 
extra USB adapter is not required.  These laptop computers will have an option to 
enable/disable the internal adapter.  Usually, this function is performed by a 
special key on the laptop keyboard or an extra sliding switch on the side of the 
laptop.  If the software is reporting a BTStackError, check that the internal 
Bluetooth adapter is enabled using the hotkey or switch. 

6.2 Bluetooth Stack 
The term Bluetooth stack refers to the collection of code on a PC which handles 
Bluetooth traffic. 

HydroSense II Support Software supports the four major Bluetooth stacks 
currently on the market: Microsoft, BlueSoleil, Toshiba and Broadcom. 

6.3 VWC 
VWC is an acronym for volumetric water content.  This is a measure of the 
volume of water present in soil expressed as a percentage of the total volume.  A 
VWC of 20% indicates that the water fraction is 20% the soil by volume. 
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Section 7. Error Codes 
7.1 Reporting an Error 

The following information is required when reporting an error code to Campbell 
Scientific. 

1) Error Code 

For example: BTStackError (0x11) 

To find out more information on a particular error code, prompt an info tip by 
pausing the pointer over the error, or click More Info.  

 

2) Steps to Reproduce the Error 

For example:  

1. Pressed the Discover button to discover the HydroSense II.  

2. Selected the HydroSense II device from the list.  

3. Pressed Connect.  

4. Connection failed with the error BTUnkownError. 

Please indicate whether these steps, prior to the error, had worked as expected.  

3) Bluetooth Adapter Make and Model  

Please supply the make and model number of the Bluetooth adapter if using a 
desktop computer.  Supply the laptop make and model number if using a laptop 
computer. 

4) Log Files 

See SECTION 7.2 Software Log Files (p. 7-1) for information on locating the 
Bluetooth and application log files. 

7.2 Software Log Files 
If you receive an error code, please follow the instructions in SECTION 7.1 
Reporting an Error (p. 7-1) to notify the local HydroSense II distributor of the 
issue.  To make identifying the cause of the error easier, please attach the 
communication and application logs to your correspondence.  
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These logs are located in the working directory of the software which can be 
opened from the options menu in the main window. 

 

The working directory contains three folders; data, logs and xml. 

 

The data folder contains records and zones downloaded from each HydroSense II 
stored in a raw binary format. These files can only be opened by the HydroSense 
II software. Use the Export to CSV option in the Data View to view records in 
Excel. 

The xml folder contains configuration information for the HydroSense II software.  

The logs folder contains two log files; bluetooth.log and application.log. 

 

The Bluetooth log file records the details of the last communication attempt with a 
HydroSense II device. 

The application log file contains start-up information and any program errors since 
the last time the software was started. 

When reporting an error, please email blueooth.log and application.log to your 
HydroSense II distributor. 
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7.3 (0x01) UserAbort 
User aborted the operation. 

 

This error is shown when a connection or synchronization attempt is cancelled by 
clicking the Cancel button. 

 

 

This error does not normally indicate a problem with communications; however, if 
it is displayed without the Cancel button being pressed, and it prevents normal 
operation of the software, please contact Campbell Scientific. 

7.4 (0x10) BTUnkownError 
An unknown error has occurred during Bluetooth communications. 

 

This error is shown when communication with the HydroSense II has failed and 
the Bluetooth driver on the local computer did not specify the cause of the failure. 

If this error has occurred, attempt to reproduce the error a second time by 
following the same steps that resulted in the first error. 

If the error is confirmed, please report the error to Campbell Scientific with the 
steps required to reproduce the error. 

 

7.5 (0x11) BTStackError 
No supported Bluetooth stack found on this computer. 
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The software did not find a compatible Bluetooth stack on the local PC.  This will 
usually occur on a desktop machine where the Bluetooth adapter has not been 
connected or on a laptop where Bluetooth has been disabled. 

First, check that the Bluetooth adapter is connected via a USB port, or that 
Bluetooth has been enabled if using a laptop.  Most new laptops have an external 
button or a keyboard key to toggle Bluetooth. 

If the Bluetooth adapter is connected, and Bluetooth is turned on, check whether 
Windows has recognized the Bluetooth adapter.  If Windows has recognized the 
Bluetooth adapter, a Bluetooth icon should be displayed in the Windows 
notification area. 

 

The Bluetooth icon should be shaded blue.  If it is shaded grey or is missing, 
Windows has not recognized the Bluetooth hardware.  Please contact the supplier 
of your Bluetooth hardware for assistance. 

If the Bluetooth icon is present, then Windows has recognized the Bluetooth 
hardware, but HydroSense II Support Software has not.  Please report the issue to 
Campbell Scientific. 

7.6 (0x12) BTSocketError 
Could not establish a connection to the HydroSense II.  

   

This error occurs when the Bluetooth adapter on the local PC is not able to create 
a connection to the HydroSense II.  This can be caused by the device being out of 
range, or not responding to Bluetooth requests. 

Try the following steps to rectify the issue: 

Make sure the HydroSense II is powered on.  Check that the display 
is on and responsive.  

Make sure that the HydroSense II is within range of the PC.  The maximum 
distance that the display can be situated away from the PC depends on the class of 

NOTE 
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the Bluetooth adapter used by the PC, as shown in Table 7-1. Bluetooth 
Transmission Distance (p. 7-5). 

Table 7-1. Bluetooth Transmission Distance

Bluetooth Class Maximum Distance 

Class 1 5 m 

Class 2 10 m 

Class 3 100 m 
 

Press the Discover button in the software again and check that a Bluetooth symbol 
is shown next to the device serial number.  

 

 

If a folder icon is shown instead, the software did not detect the device during the 
discovery process.  Restart the PC software and the HydroSense II and then 
attempt another discovery.  

If the device is still not discovered by the software, or if the device is being 
discovered but cannot establish a connection, please report the issue to Campbell 
Scientific.  
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7.7  (0x21) HydrocolNoResponse 
Did not receive a response from the HydroSense II. 

 

The software did not receive a response to a request sent via Bluetooth.  This 
means that the Bluetooth connection was successfully connected, but 
communications after the initial connection failed. 

Failure may be caused by: 

• Another device in the area is accepting Bluetooth connections with a name 
beginning with the letters "HYD".  Check that the serial number of the 
currently selected device in the software (the 5 digits after HYD) matches the 
serial number printed on the HydroSense II.  If multiple HydroSense II units 
are within Bluetooth range, turn off all but one. 

• The HydroSense II has been taken out of Bluetooth range after the initial 
connection.  Ensure that the HydroSense II is well within the Bluetooth range 
specified by the Bluetooth adapter on the local PC. 

• There is a fault with the HydroSense II or the PC software.  If the No 
Response error can be reproduced a second time, and the preceding steps do 
not fix the issue, please report this to Campbell Scientific. 

7.8 (0x22) RemoteFileNotFound 
Remote file not found. 

 

Data and zone information are stored in files on the HydroSense II.  During 
synchronization, the software downloads these files from the device.  If this error 
occurs, it means that the remote device does not recognize the file the software is 
asking for. 

This can be caused by an older version of the software communicating with a 
device with new firmware.  Please visit www.campbellsci.com to check whether 
an updated software version is available. 

If the latest version of the software is being used, please report the issue to 
Campbell Scientific. 

7.9 (0x25) InvalidPacket 
Invalid packet received. 
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The software has received a response from the remote that is either the wrong 
length or has an incorrect format.  

This can be caused by an older version of the software communicating with a 
device with new firmware.  Please visit www.campbellsci.com to check whether 
an updated software version is available. 

The error can also be caused by a weak Bluetooth connection with the remote 
device.  Ensure that the device is well within the maximum distance quoted by the 
Bluetooth adapter on the local machine.  The maximum communication distances 
for Bluetooth adapters are listed in Table 7-1. Bluetooth Transmission Distance.  

If the error persists, please contact Campbell Scientific. 

7.10 (0x26) UnexpectedResponse 
Unexpected response received from the device. 

 

The software has received a properly formatted response from the HydroSense II, 
but it is not the response that the software was expecting.  This can be caused by 
an older version of the software communicating with a device with new firmware.  
Please visit www.campbellsci.com to check whether an updated software version 
is available.  

If the latest version of the software is being used, please report the issue to 
Campbell Scientific. 
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Section 8. Operating System Updater 
Sending an operating system to the HydroSense II will 
permanently delete all measurements and zones saved 
on the device.  Please ensure that the HydroSense II is 
synchronized with the PC software before sending a new 
operating system.  This will save all of the HydroSense 
II’s data points and zones on to the PC. 

The software includes a facility to update the operating system on the HydroSense 
II.  This can be run from the Operating System Updater shortcut under the 
Campbell Scientific > HydroSense II group in the Windows Start menu. 

 

WARNING 
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8.1 Bluetooth Provider 
The facility uses Bluetooth to transfer a new operating system to a HydroSense II 
display.  The Bluetooth provider used is shown in the upper portion of screen.  A 
Bluetooth provider refers to either a USB dongle or a built-in USB chip in a 
laptop.  If no Bluetooth provider is found, the following screen will be displayed. 

 

Make sure that Bluetooth is enabled on the local PC.  Bluetooth can be toggled 
using an external switch on a laptop or a special function key on the keyboard.  
Bluetooth can also be toggled using the Bluetooth icon in the Windows 
notification area.  If Bluetooth is enabled and working with other devices and the 
error in the preceding figure is still displayed, please contact Campbell Scientific. 

If multiple Bluetooth providers are available, click the browse button next to the 
current provider to select a different provider: 

 

The currently selected provider will appear in bold in the list.  To activate a 
different provider, double-click on its name, or select the provider and press the 
Activate button.  Then close the window using the Close button. 
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8.2 Discovering the Device 
To send an operating system to the device, it must be powered on in “boot loader” 
mode.  The procedure to do so is as follows: 

• Make sure the HydroSense II is turned off 

• Press and hold the up arrow button 

• With the up arrow still depressed, press and hold the power button for two 
seconds 

The HydroSense II will power on in “boot loader” mode and flash the LCD 
display. 

The device will remain in this mode for two minutes.  Return to the software and 
press the Discover button.  The device should be displayed with its serial number. 
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8.3 Sending an Operating System 
Select the device, and then press the Send Firmware button.  

 

Before choosing a firmware to send to the device, a warning dialog is shown as 
below:  

 

Ensure that all data points and zones on the device have been synchronized with 
the PC software before continuing.  

Press Cancel to return to the Operating System Updater and cancel the send 
operation. 

Press OK to agree to remove all saved data points and zones from the device 
during the operating system update. Note that any previous zones stored by the PC 
software can be re-uploaded to the device by performing synchronization with the 
device immediately after the update is completed. 
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A file browser will open allowing you to select the new operating system.  When a 
new operating system becomes available, it will be listed at 
www.campbellsci.com/downloads.  It is this file that should be selected in the file 
browser. 

 

Click the Open button to begin the transfer.  The HydroSense II will flash the 
LCD display rapidly to indicate a transfer is in progress. 

 



Section 8.  Operating System Updater 

8-6 

The device will first erase the old operating system.  This process takes about 30 
seconds to complete. 

 

When the old operating system is erased, the facility will transfer the new 
operating system to the device.  This process takes about 90 seconds to complete.  
A progress bar reports the transfer progress. 
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If there is a Bluetooth error while transferring the operating system, the error will 
be shown below the progress bar.  The HydroSense II will turn off, and the 
operating system transfer will fail.  At this point, the HydroSense II will not power 
normally on as it has an incomplete operating system.  The device can still be 
powered on in “boot loader” mode.  In event of an error, repeat the operating 
system transfer procedure.  If the error continues, please contact Campbell 
Scientific. 

 

Once the transfer is complete, the HydroSense II display will power off and the 
update facility will display a message indicating the transfer was successful.  The 
HydroSense II display can now be powered normally. 

Before storing data points on the device, perform a Synchronise with the 
HydroSense II.  This will upload the zones stored on the PC to the HydroSense II, 
as the device zones would have been cleared during the upgrade process. 
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